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The information contained in this document represents the current view of 
Compulink Management Center, Inc on the issues discussed as of the date of 
publication.  Because Compulink must respond to changing market conditions, it 
should not be interpreted to be a commitment on the part of Compulink, and 
Compulink cannot guarantee the accuracy of any information presented after the 
date of publication. 
This chapter is for informational purposes only.  COMPULINK MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, AS TO THE INFORMATION IN THIS 
DOCUMENT. 
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A number of features in Laserfiche 8 can help you work more effectively with 
documents in your repository.  Certain tricks and procedures can help you 
save time and manage documents flexibly and efficiently.  

Tips for Administering Your Repository 

Keep Volume Size Manageable with Logical Volumes 

You can use logical volumes in Laserfiche to keep volumes from growing 
unmanageably large.  Larger volumes take longer for the server to load, so 
allowing volumes to become very large can negatively impact performance. 
Large volumes can also cause problems when backing up and archiving, as 
they are time-consuming to copy and may not fit on standard backup media. 

Logical volumes appear to the user as one volume, but divide files between 
multiple sub-volumes, each of which has a size limit. You can configure the 
size limit to ensure that your sub-volumes remain small enough to avoid 
performance issues and fit onto your backup media.  Whenever one of the 
sub-volumes reaches its size limit, another sub-volume is automatically 
created by the server; however, users can continue to scan, import and search 
as if there was only one volume. 

In effect, the logical volume acts as a container for the sub-volumes, which are 
invisible to the user through the Laserfiche interface but contain the physical 
files in their locations on the hard disk.  The work of keeping the sub-volumes 
at a manageable size is done behind-the-scenes by the server.  Using logical 
volumes in this way allows you to keep a relatively simple volume structure 
without allowing your volumes to grow unmanageably large. 

Allowing Windows Domain Users to Log In to Laserfiche 

Like Laserfiche 7, Laserfiche 8 allows you to add Windows domain account 
users and groups directly to your repository, so that they can log in using 
Windows authentication rather than needing to type a username and 
password.  Laserfiche 8 introduces the ability to treat these domain users and 
groups like any other user in Laserfiche.  Thus, administrators can grant 
security rights – feature rights, access rights, privileges, and tags – directly to 
these domain users and groups, configure auditing for them, and otherwise 
treat them exactly the same as Laserfiche trustees. 

This ability simplifies user and group administration and maintenance.  It is 
not necessary for an administrator to create new users manually; if a Windows 
account for a new user has been created on the domain, that user can simply 
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be added to Laserfiche and administered normally, without needing to tie 
them to Windows trustees.  If a user leaves the organization, the administrator 
can simply remove their Windows account; the corresponding Windows 
account in Laserfiche will also be removed.  Furthermore, this ability allows 
users to authenticate directly to Laserfiche based on their Windows username; 
they do not need to remember an additional username and password for the 
repository. 

Copy Administrative Objects  

Laserfiche 7 lets users with the proper authorization copy and paste 
administrative objects such as users, groups and templates.  When pasted into 
a different repository, a user or group retains the same set of privileges, 
facilitating the creation of new repositories with the same or some of the same 
users and templates as another repository. 

This functionality also applies to public stamps, tags, relationships, audit 
reports, and records management objects. 

Recycle Bin 

Laserfiche 8 features a new Recycle Bin feature, which allows users and 
administrators the opportunity to review and restore deleted items before they 
are permanently purged.  When a user deletes an entry, it is moved to a 
special folder.  Users can view and restore the documents that they have 
deleted, and privileged users can view and restore all documents.  Unlike the 
Windows recycle bin or Macintosh trash can, however, this recycle bin is 
network-wide.  When a document is restored, all of the information for that 
document – including tags and security settings – will be restored also.  
Privileged users can also purge documents from the recycle bin, thus 
permanently deleting them. 

Privileged users can review and, if they choose, retrieve deleted items both 
within the client recycle bin and in the Administration Console.  In the 
Administration Console, they can review all deleted items or items sorted by 
the user who deleted them.  Administrators can also configure how long an 
entry will wait in the recycle bin before it will automatically be purged, or can 
specify that entries should only be purged manually.  This prevents 
accidental deletion and purging of important documents. 
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Default Security 

Whenever you create a new volume, template or field, Laserfiche creates a 
starting set of security for that new object.  In previous versions of Laserfiche, 
the Server used a generic set of starting rights, but in Laserfiche 8 you can 
customize the starting default security for your volumes, templates and fields. 

In the Laserfiche 8 Administration Console, you can set up default security for 
volumes, templates, or fields.  Laserfiche will then automatically apply your 
default security to all objects of that type that are created after that point.  
(Default security won't affect volumes, templates or fields that have already 
been created.)  You can configure default security by user, group or Windows 
account, just like regular security.  You can also grant special rights to the 
object's creator.   

For example, by default you might want to grant the Volume right Read to all 
users, the rights Read, Create documents and Append Data to the Scanner 
Operators group, and all rights to the Administrators group.  Then, whenever 
you created a new volume, these rights would be the default starting rights for 
the volume.  You could still customize the security for individual volumes – 
Default Security simply allows you to customize the starting security 
configuration. 

New Privileges 

Laserfiche 8 introduces several new privileges to help you manage your 
repository more easily.  Some privileges allow you to more easily distribute 
administrative tasks between multiple users, while others enhance 
performance for the users they have been granted to.  In some cases, you may 
wish to grant some of these new privileges to regular users, rather than 
restricting them to administrative users. 

Purge Entries 

Laserfiche 8 includes a new recycle bin feature, which allows administrators 
and users to review the documents that have been deleted before they are 
permanently purged from the repository.  Administrators with the Manage 
Entry Access privilege can review, restore and purge any deleted entries, and 
users with the new Purge Entries privilege can purge entries that they have 
deleted themselves.  Granting this privilege allows users to manage their own 
deleted documents and determine whether they should be permanently 
removed.  If you would like a user to be able to decide whether a deletion 
should be permanent, you should give him or her this privilege.  For more 
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information, see the Recycle Bin chapter of the Administration Console help 
files. 

Manage Filter Expressions 

Folder filter expressions are a new security feature introduced in Laserfiche 8 
that allow administrators to set security dynamically.  A filter expression is an 
advanced string defined by an administrator and set on a folder, which uses 
the field values of individual entries within the folder to determine what 
users should be able to access what entries.  The Manage Filter Expressions 
privilege determines who can set filter expressions on folders in the 
repository.  (The user must also have the Write Security entry access right for 
a folder to set its filter expression.)  For more information, see the Folder 
Filter Expression section of the Administration Console help files. 

Bypass Browse and Bypass Filter Expressions 

As security grows more granular and complex, the Laserfiche Server must 
perform more security checks to determine whether a particular document 
should be displayed to a user.  This does not generally impact performance 
when browsing a repository, but returning a search results list with many hits 
may be slower, as the Server must calculate security for each entry in the 
search results before they can be displayed.  The Bypass Browse and Bypass 
Filter Expressions privileges speed up security calculations by allowing the 
Server to ignore the Browse right or the parent folder's filter expression for the 
user the privileges have been applied to. 

Because these privileges ignore the Browse right and the folder filter 
expressions in the repository, they should only be granted if you are not using 
these security features to restrict access for that user.  For instance, if a user 
has the Browse right for the entire repository, you should grant them this 
privilege in order to improve their performance, since it would not grant them 
access to any document they wouldn't be able to see anyway.  Similarly, if 
you are not using folder filter expressions in your repository, you should 
grant the Bypass Filter Expressions privilege to the Everyone group, as it 
would improve performance without affecting access.  However, if you do 
choose to use filter expressions, or if a user should have their Browse access 
restricted, they should not be granted these privileges. 

In a new repository, Bypass Browse and Bypass Filter Expressions are 
granted to the Everyone group to begin.  In a migrated repository, only Bypass 
Filter Expressions is granted to the Everyone group, since the folder filter 
expression feature was not present in Laserfiche 7 and therefore will not be 
relevant in a newly migrated repository. 
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Distributed Metadata Privileges 

In Laserfiche 7, the ability to modify metadata types was controlled by a 
single privilege, Manage Metadata.  In Laserfiche 8, Manage Metadata has 
been split into several separate privileges: Manage Templates and Fields, 
Create Templates and Fields, Manage Stamps, Manage Tags, and Manage 
Links.  This allows you to distribute the ability to modify metadata to exactly 
the users who need particular rights.  It is no longer necessary, for instance, to 
grant the ability to modify tags (which can be very powerful, in the case of 
security tags) along with the ability to create or modify a field.  Additionally, 
due to new template and field rights, it is not necessary to grant the Manage 
Templates and Fields right simply to allow a user to modify a particular 
template or field.  They only have to be granted the appropriate rights for that 
particular field or template. 

Trustee Attributes 

Trustee attributes are the settings specific to a particular user that influence 
the way they use the Laserfiche Client.  Trustee attributes include information 
such as what columns will be displayed in the Client and how they will be 
sorted, what Quick Search settings should be used by default, how the toolbar 
should be displayed, what import options should be used, how the document 
viewer should be displayed, and what scanning options should be used by 
default.  Trustee attributes are specific to a particular user – if one user 
customizes the column display for the Client, they will thereafter see their 
own column display, but won't affect other users. 

In Laserfiche 7, trustee attributes were stored in the registry.  This allowed 
them to be specific to particular users, but also made them computer-specific.  
In Laserfiche 8, trustee attributes are still user-specific, but are stored on the 
Server.  This means that a user logging in on several different workstations 
will still always see the Client using their own settings. 

Laserfiche 8 also introduces an interface that allows you to view and modify 
trustee attributes directly from the Laserfiche Administration Console, 
without needing to open or modify the registry.  A user with the Manage 
Trustees privilege can log in to the Administration Console, open Properties 
for any Laserfiche or Windows Account user, and then select the Attributes 
tab.  This tab lists all currently-set properties and their values.  (If no property 
is set for an option, the user will use the default setting.)  

You can also use this interface to copy attributes from one user to another.  
Simply select the property or properties you would like to copy, right-click, 
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and select Copy.  Then open the user you would like to apply this property to, 
right-click in the attributes list, and select Paste.  For instance, you could use 
this process to copy a column display setting from one user and paste it into 
several other users to give them the same column display. 

If you would like to change the default attribute for all users in the repository, 
you can do so by setting the attributes for the Everyone group.  Modifying the 
Everyone group is the same as modifying a user: open the Everyone group 
properties and select the Attributes tab.  You can then modify properties as 
you would with a user. 

For example, to set a starting column display for all users, you could log in to 
the Client as your own user account and customize column display in the way 
that you wish to use for the default.  You could then log in to the 
Administration Console, copy the Column Display attribute from your trustee 
attributes, and paste it into the Everyone group.  This column display setting 
will function as a new default, and will affect all users who do not have a 
customized column display setting of their own.  However, users who have 
customized their own column display will not be affected by this new default. 

Note: Trustee attributes should be set either on individual Laserfiche or 
Windows Accounts users, or on the Everyone group.  Laserfiche client 
applications only read attributes from individual users or the Everyone group.  
The ability to set attributes on these groups is included for use with 
integrations and customizations. 

Trustee Management 

Laserfiche 8 introduces several new features that make it easier to manage 
your trustees and security policies.  These features include the ability to 
generate a random password for users, the ability to ignore maximum 
password age, and the ability to lock an account that has been inactive for 
more than a certain period of time.  For more information about new features 
in Laserfiche 8, check out one of the Laserfiche 8 presentations at the 
conference. 

Password Generation 

The Laserfiche 8 Administration Console can generate a new, random 
password for a user.  If you have configured a password complexity policy for 
your repository, this random password will comply with that policy. This 
allows you to quickly generate a secure password as needed.  Random 
password generation is useful for initial user account creation: an 
administrator can create a user, generate a random password, and give the 
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starting password to the user, without having to think of a sufficiently secure 
password.  It is also useful for users who have forgotten their password and 
need to have it reset. 

Random password generation is especially useful in conjunction with the 
User must change password at next login feature.  Thus, an administrator can 
create a new, random password, and then prompt the user to change it to a 
password of their own choosing when they log in. 

Ignoring Maximum Password Age 

In Laserfiche 7.2, we introduced the ability to force users to change their 
passwords after a certain number of days have elapsed.  Laserfiche 8 
introduces the ability to exempt certain users from this aspect of the security 
policy; that user will never be forced to change their password.  For instance, 
you might have an integration that runs on an automated schedule and logs in 
as a specific, dedicated Laserfiche user.  Since no actual human logs in as this 
account, no one would be able to see that the password was about to expire – 
and when the password did expire, the integration would cease to work.  To 
circumvent that, you could set up the dedicated user for that integration such 
that your maximum password age setting is ignored. 

You will want to be certain that this password is not widely known.  If you 
have strict security policies, you may not want to take advantage of this 
feature. 

 

Account Inactivity 

In Laserfiche 8, administrators can choose to automatically lock accounts that 
have been inactive for more than a specified number of days.  If no one has 
logged into the account after that number of days, the account will become 
inactive and no one will be able to connect to it.  Note that this does not 
delete the account – it merely prevents users from logging in using that 
account until it has been re-enabled by an administrator.  This increases 
security by ensuring that old accounts – which, for instance, might not have 
had their passwords changed in a long time, or which might belong to users 
no longer with the organization – are not accessible. 

New Template and Field Features 

New Field Architecture 

In Laserfiche 8, fields exist independently from the templates that contain 
them.  In other words, a template collects a number of fields – which can be 
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created separately from the template – rather than defining the fields.  This 
has a number of advantages for the administrator and the user.   

An administrator can create a single field (for instance, a field named "Filing 
Date") and apply it to more than one template.  This saves time, as the admin 
no longer need to create a "Filing Date" field for each template whose filing 
date he or she wishes to track.  More importantly, it allows for more efficient 
searching for the user, since you can search for a particular date in any of the 
"Filing Date" fields in the repository, regardless of what template they are a 
part of.   

An administrator can also delete a template without deleting all the fields 
contained by the template, or can make changes to a field that will apply to all 
instances of the field in the repository.  Furthermore, users with appropriate 
rights can add fields directly to documents without needing to add them to a 
template first.  For instance, if a few certain documents should have the 
"Routing Information" field, but most documents do not need it, a user could 
simply add the "Routing Information" field directly to those documents that 
need it, regardless of the template that is applied to the document. 

Multi-Value Fields 

A multi-value field allows you to store more than one piece of information 
easily within a single field.  For instance, you could create an Author field as 
a multi-value field. Then, if you needed to store a report or other document 
that had been worked on by more than one person, you could simply save 
each author's name as a value within that field.  Multi-value fields 
automatically expand as you fill them to contain as many values as you need. 

If you search for a value that is contained within the multi-value field, the 
document or folder will be returned if any of its values match your search.  
For instance, if you have an e-mail with many e-mail addresses stored in a 
Recipients list, you can search for any one of those e-mail addresses and 
retrieve the original e-mail. Additionally, any length limitations or constraints 
for the field will be applied to each value within the field.  If you have set up 
a constraint to force all phone numbers to be stored in 123-456-7890 format, 
this constraint would be in effect for each of the phone numbers stored in that 
field.  All field types can be set to be multi-value fields. 
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Tips for Using the Laserfiche Client 

Customize the Laserfiche Client 7 Shortcut 

You can customize the desktop shortcut to the Laserfiche Client 7 to 
automatically log you in to a particular Laserfiche repository. To specify a 
particular repository for a desktop shortcut to the Laserfiche Client, right-click 
the shortcut to the Laserfiche Client and select Properties.  Select the Shortcut 
tab.  In the Target option, you will see a line similar to the following: 
"C:\Program Files\Laserfiche\Client\LF.exe" 

 Add to this line so that it looks like the following example: 
 "C:\Program Files\Laserfiche\Client\LF.exe" -L"RepositoryName" 

 where RepositoryName is the name of the repository you wish to 
automatically log in to. Once this has been done, if you open the Laserfiche 
Client, it will automatically bring up the log in dialog for that repository – no 
need to select it from the list. 

If you have configured Windows Accounts in Laserfiche or associated 
Windows users with Laserfiche users, you can use Windows Authentication 
to automatically log users in to Laserfiche.  You can modify the Target option 
in the following fashion: 
"C:\Program Files\Laserfiche\Client\LF.exe" -L"RepositoryName" –U 

When a Windows user opens the Client using this shortcut, they will be 
automatically logged in to Laserfiche if a Windows Account or Laserfiche user 
has been associated with that Windows user. 

You can also customize the shortcut to link directly to a particular folder or 
entry in Laserfiche.  To do so, use the following syntax: 
"C:\Program Files\Laserfiche\Client\LF.exe" –L"RepositoryName" -
EObjectID 

where ObjectID is the entry ID of the folder or file the shortcut should link to. 
T his can be combined with the -U  flag to log the user in and then take them 
directly to the document. 

You can also create a link directly to an entry by dragging a shortcut to a 
document or folder to the desktop. These shortcuts can also be e-mailed to 
other users who have access to the repository where the original entry resides.  
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• To create a shortcut to a document located in your repository, hold 
CTRL + SHIFT while dragging it to Windows Explorer.  

• To create a shortcut to a folder inside your repository, drag the folder to 
Windows Explorer. 

Drag and Drop Text in the Document Viewer 

You can drag and drop text in the Laserfiche Client from the Text pane to the 
Template pane.  This is useful for quickly populating template fields without 
needing to retype information.  For instance, if you wished to store the 
senders of a set of business letters in a Sender field, you could copy the 
sender's name from the address block of the OCRed letter. 

In order to use this feature, you will first need to OCR or extract text from the 
document in question.  Once the document has been OCRed, open the 
document viewer.  If the document viewer is not currently displaying the text 
pane, you will need to open it by selecting Text from the View option on the 
View menu. 

 You can select the text you wish to copy in the Text pane and drag it into the 
relevant template field.  This will copy the line of text exactly without moving 
it.  (Note that the template fields can only receive one line of text at a time.  If 
the words you wish to copy are broken onto two lines, you may need to 
perform the drag and drop copy twice to get all of the words.)  If you are 
modifying the text in the text pane, this process will actually remove the 
selected text from the text pane and place it in the template field, effectively 
acting as a cut and paste rather than copy and paste process.  If you wish to 
simply copy rather than cut the selected text, hold down the CTRL key while 
dragging the text into the relevant template field. 

With multiple document viewers open, you can drag the text from one 
document's template field into another document's fields.  Please note that, in 
all cases, you will need the appropriate Template Field rights to populate a 
template. 

Copy a Selection from a Laserfiche Image 

In Laserfiche 8.0.1 and later, you can copy all or part of a Laserfiche image file 
by selecting a portion of the file, copying it, and pasting it into another 
application.  Additionally, if the image has been OCRed, any text that is 
associated with that section of the image can be copied as text into a text 
application. 
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When the copied selection is pasted into an application, that application will 
be able to automatically determine the format in which it should be pasted.  
For instance, if you paste into a graphics program such as Paint, the selection 
will paste as an image; if the selection has OCRed text, and you paste it into a 
plain text editor such as Notepad, it will paste as text.  

Many applications will allow you to paste as either format: Word will 
automatically paste as text, but if you go to the Edit menu and choose Paste 
Special, you can elect to paste it as a bitmap image.  Additionally, if the 
selection has not been OCRed, it will automatically paste into applications 
that support text and images (such as Word) as an image. 

Furthermore, the selection will be pasted as whole words rather than leaving 
dangling letters where the selection cuts across a word.  When part of a word 
is selected, the entire word will be copied if at least half of it is within the 
selection box.  If less than half of the word is within the selection box, none of 
it will be copied. 

To copy a selection from an image 

1. Within the Laserfiche Client 7.1 or 7.1.1, select the file you wish to 
copy from.  Open it by double-clicking or by selecting Open from the 
File menu.  Note that the document must be OCRed if you wish to be 
able to paste it as text.  

2. Use the pointer to select a region of the image.  Click and drag to draw 
a box around the area you wish to copy.  

3. Copy the selection.  You can do this by selecting Copy from the File 
menu, by right-clicking and choosing Copy, or by pressing CTRL-C.  

4. Open the application in which you wish to paste the selection.  Note 
that the selection cannot be pasted anywhere within Laserfiche as an 
image, although text can be pasted into other Laserfiche text files.  

5. Paste by pressing CTRL-V, or by selecting the Paste command within 
the application. 

Manage Documents Using Thumbnails 

Rotating Thumbnails from the Thumbnail View 

In Laserfiche Client version 7.1 and higher, you can rotate multiple 
thumbnails directly from the thumbnail view. Select one or more thumbnails, 
then either go to View > Rotate Selected Images or right-click and select 
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Rotate Selected Images. You can choose to rotate the thumbnail or thumbnails 
clockwise or counterclockwise 90 degrees, or to turn them upside-down. 

The new page rotation will only be saved when you close the document if you 
have Modify Contents rights for that document. However, if you do not have 
Modify Contents rights, you can still rotate the image in order to better view it 
- the orientation will simply not be saved when you close the document. 

Jumping To a Thumbnail 

You can jump to a particular thumbnail by selecting the thumbnail pane and 
typing the number of the thumbnail. This will bring you directly to the 
thumbnail you input, and the thumbnail will be selected. This can be useful 
for moving quickly between thumbnails in a large document, where scrolling 
would take a long time. 

Use Briefcases to Reproduce Folder Structures 

In some situations, you may wish to have a complicated file structure that 
will need to be repeated in various places in the repository.  For instance, a 
human resources department might want to keep a file for documents 
pertaining to each employee, with different folders for application, insurance 
records, tax documents, background check, and performance reviews.  
Perhaps the performance review folder is further subdivided into customer 
comments and quarterly reviews. 

The Laserfiche Client allows you to reproduce folder structures from within 
the Client itself, allowing you to quickly create new sections of your folder 
tree without tediously creating them by hand.  The folder structure is copied 
to a new location, but the documents inside the folders are not. This allows 
you to easily reproduce standardized folder structures, such as client records.  

To reproduce folder structures: 

1. From the Folder Browser, select the folder structure you want to 
reproduce.  

2. Right-click and select Copy, or select Copy from the Edit menu.   

3. Navigate to and select the folder structure’s new location.  

4. Right-click and select Paste Folders Only. 

5. You will get a prompt confirming the reproduction. To turn this 
prompt off, select the check box next to Don’t ask me again. Click Yes 
if you want to reproduce the folder structure.  
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6. The folder structure will appear as a copy of the original, without any 
documents inside.  

Note: You must have Create Folders rights to reproduce a folder structure. 
Rights assigned to any folder within the structure are not copied to the new 
location. 

Adding New Buttons to the Laserfiche Client Toolbar 

You can add new buttons to the Laserfiche Client Toolbar that will allow you 
to launch applications quickly from within the Client.  These can be used in a 
variety of ways: to start a Toolkit application, to access a web site, to start a 
program that you frequently use in conjunction with Laserfiche, and more.  
Furthermore, custom toolbar buttons are stored on a particular computer and 
are specific to a particular Windows user, so various users who use 
applications in different ways can have different custom toolbars. 

Creating a Custom Button 

To create a custom button, open the Options dialog in the Laserfiche Client.  
(The Options dialog can be accessed from the Tools menu.)  From the Options 
dialog, select Toolbar and click the Customize Toolbar button.  This will 
open the Customize Toolbar dialog, which allows you to modify your toolbar 
settings.  To add a new, custom toolbar button, click the Custom… button.  
This will open the Custom Toolbar Buttons dialog.  To add a new button, 
click Add…. 

The Toolbar Button Properties dialog has three boxes: Name, Command and 
Icon.  In the Name box, type the name you would wish to associate with the 
new custom button.  In the Command box, type the path to the application 
you wish the button to open.  For instance, to create a button to open Internet 
Explorer, you would type the path to the iexplore.exe file, which launches 
Internet Explorer.  Finally, in the Icon box, select an icon for the application.  
Many executable files have a number of icons associated with them; you can 
select one of these files and then browse the available icons to choose one. 

Once you have filled all three boxes, click OK to close the Toolbar Button 
Properties dialog.  To add the new button to the toolbar, select the Commands 
tab, and then select the Custom category.  Drag the new button to the toolbar. 

You can also further customize the new toolbar button to make it even more 
immediately useful. 
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Opening a Website 

You might want to go directly to a particular website when you click a button 
in the Client – for instance, your company or organization's website.  You can 
do this by customizing the Command box of the Toolbar Button Properties to 
point to a particular website.  For instance, you could create a toolbar button 
that would automatically open the Laserfiche Support Site so that you could 
quickly find technical suggestions or white papers.  To do this, you would 
add the website's URL to the Command box after the path to the program.  If 
Internet Explorer is located in its default location, you could type the 
following in the Command box: 
C:\Program Files\Internet Explorer\IEXPLORE.EXE 
"http://support.laserfiche.com" 

When the button is clicked, Internet Explorer will be launched and will 
immediately open the Support Site. 

Opening an Excel Spreadsheet 

Similarly, for many applications, you can specify a path to a particular file 
that you wish to be opened.  For instance, if you frequently used a particular 
spreadsheet in conjunction with Laserfiche, you could create a button that 
would not only open Excel, but also immediately open that spreadsheet.  
Again, this can easily be done by adding information to the Command box – 
in this case, the path to the file.  If Microsoft Excel is located in the 
C:\Program Files\Microsoft Office\OFFICE11 folder, you could type the 
following in the Command box to open Info.xls from a Spreadsheets folder: 

C:\Program Files\Microsoft Office\OFFICE11\EXCEL.EXE 
"C:\Spreadsheets\Info.xls" 

Folder Template Field Inheritance 

Folder template field inheritance allows you to set a value in the folder's 
template field and then propagate it to documents created within that folder.  
This allows you to take advantage of your folder structure to fill template 
fields.  Folder template field inheritance uses the $parent$ and $parent:field$ 
tokens.  You can use these tokens in the Client, set them as default template 
values, or use then with any application that interacts with the Laserfiche 
Server – such as Laserfiche Scanning or your own Toolkit scripts. 

Laserfiche replaces the $parent$ token with the value from the corresponding 
folder field.  For instance, if you typed the $parent$ token into the Author 
field of a document, Laserfiche would replace it with the value in the Author 
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field of the parent folder. If the parent folder didn't have an Author field, or if 
that field was blank, the token would be replaced with a blank value. 

If you want to inherit a different value from the parent folder's template, you 
would use the $parent:field$ token.  For instance, your parent folder might 
have a field called Subject, and you might want to fill a child document's 
Type field with that value.  You would type $parent:subject$ into the child 
document's template field.  This works even if the parent folder has a 
different template than the document. 

Parent field inheritance is particularly useful when used in conjunction with 
default values.  For instance, you might regularly scan all documents 
pertaining to a particular customer into a folder for that customer.  You could 
set up your parent folder with a "Client" field, and then set the default value 
for the "Client" field to $Parent$ for that template. Then, every document 
scanned into those folders would automatically be filled with the client's 
name. 

Sticky Note Features 

Sticky Note Hyperlinks 

You can create hyperlinks in your sticky notes that will allow users to go 
directly to a website by clicking on the link in the note. When type the URL to 
a website, the URL will automatically be changed into a clickable hyperlink.  
You can use other linking protocols as well, such as a path beginning with 
ftp:// to link to an FTP site, or a path beginning with file:// to link to file on 
the hard drive. 

Sticky Note Search 

You can open sticky notes directly from the Search pane when you search for 
sticky note text.   To do this, you must have context lines displayed in search.  
To display context lines, open the Tools menu and select Options and then 
Search.  Make sure that Show context lines is checked. 

When you search for sticky note text, you can double-click on the displayed 
context lines.  This will open the document directly to the page which 
contains the sticky note, and open that sticky note with the searched text 
highlighted. 

Sticky Note History 

Sticky note history allows you to see revisions made to sticky notes, the user 
who created them, what date they were created or modified, and what the 
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new text is. This feature can be activated in the Administration Console and 
within the Client. 

To activate the Sticky Note History in the Client, select the sticky note button 
on the toolbar and place a sticky note on the image. Right-click the sticky note 
and select Properties. Choose the History tab. Select the Keep History check 
box and click OK. Every time someone edits the sticky note, it will be 
documented in the Sticky Note History tab. Clicking on a revision in the 
History tab displays the full text of that version in the Full Text section of the 
Sticky Notes Properties dialog box. 

To activate the Sticky Note History in the Administration Console, select the 
desired repository and click Repository Options.  Double-click Settings. 
Double-click New sticky note history. Select the Track sticky note history for 
all future changes check box under the New Sticky Notes section, and click 
OK. This will track changes to new sticky notes. To track changes of existing 
sticky notes with text, click the Activate button under the Current sticky 
notes section. 
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Search Tips 

Quick Search 

Quick Search gives users the ability to perform a general search quickly 
without opening the Search Pane. The Quick Search bar is available within 
the Laserfiche Client in the upper right-hand corner of the Folder Browser 
screen. By default, it searches text and all fields, but users can also choose to 
search entry names, annotations, or a combination of any of these. 

The quick search is an OR search, meaning not all search criteria has to be 
met to return a search result. For example, a quick search is performed on text 
and fields for the word Shakespeare. This search will return all entries that 
have the word Shakespeare in the text, or in any field, or both.  

To perform a quick search: 

1. Type the text you want to search into the quick search text box. 

2. Choose the search criteria by clicking the down arrow to the right of the 
quick search text box. 

3. Press Enter. 

Note: If you have more than one repository attached to the Client, you can 
choose which repository you want to search by clicking Choose Repository to 
the left of the quick search text box. 

Advanced Searches 

Advanced searching is a powerful way to locate documents and manage your 
Laserfiche repository. You can perform an Advanced Search by opening the 
Search pane, selecting Text Search and then clicking the Advanced Text 
Search tab. 

You can connect search terms using & (which represents AND), | (which 
represents OR) or – (which represents NOT). To find all documents that 
contain both the words Inventory and Received in the text, you could type 
Inventory & Received in the search box. If you wanted to find all documents 
that contain either the word Inventory or the word Received, you would use 
the syntax Inventory | Received. If you wanted to find all documents that did 
not contain the word Received, you would search for -Received. 

These can be combined to form flexible, powerful searches. To search for all 
documents whose text contains the word Loan and either the words Auto or 
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Home, but not any documents that contain the word Student, you could 
perform the following search: 
Loan & (Auto | Home) -Student 

You can also use wildcards in advanced searches. A question mark in an 
advanced search stands for a single unknown character. For instance, if you 
were searching for a name but were unsure whether it was spelled Peterson or 
Petersen, you could search for Peters?n to match both. An asterisk stands for 
zero or more unknown characters. You could search for retract* to match the 
words retract, retraction, retracts and retracted. 

Searching for Electronic Documents 

You can use both standard and advanced searches to help you easily manage 
large numbers of documents. While searches can be powerful on their own, 
combining searches gives you even more flexible control of your documents 
and repository. 

Searching by Electronic Document Type 

With both standard and advanced searches, you can search for all documents 
of a particular electronic document type.  In the Client's Search pane, select 
Customize Search and then select Electronic Documents.  Choose "Find 
electronic documents."  If you select "Search for the following extensions," 
you can specify the electronic document types you wish to be returned.  (To 
select more than one document type, hold the CTRL key at the same time you 
click on the extensions.)  This allows you to search for particular types of 
electronic documents if you want to manage certain electronic documents in a 
particular way. 

Note: The list of extensions includes those extensions that exist or have 
existed in that particular repository, and so may vary from installation to 
installation, depending on what types of files have been present. 

To perform an electronic document extension search in an advanced search, 
use the following syntax: 
{LF:Ext="extension"} 

Where extension is the extension for which you are searching – for instance, 
{LF:Ext="doc"} would return only electronic documents with a .doc extension. 

Searching by Whether a Document Has Pages 

You can search for documents based on whether or not they have pages, and, 
if so, whether those pages are OCRed.  From the Search pane, select 
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Customize Search and then Has Pages.  Select "Find documents with no 
pages" to find documents that have neither images nor text associated with 
them.  For instance, this search would return electronic documents that have 
not had Snapshot run on them nor had text extracted from them, as well as 
documents containing template information but no images or text.  "Find 
documents with pages" will return all documents that have either images or 
text associated with them. 

To perform a 'has pages' search in an advanced search, use the following 
syntax:   
{LF:AssociatedPages=X} 

where X is Y if you wish to search for documents with pages, and N if you 
wish to search for documents with no pages. 

If you wish to search for documents with pages, you can also search based on 
whether those pages have been OCRed.  Select "Search for the following pages 
OCRed," and choose All, Some or None.  All will return documents in which 
all images pages have been OCRed; it will also return electronic documents in 
which the entire document has had text extraction performed.  Some will 
return all documents in which at least one but not all image pages have been 
OCRed.  None will return all documents on which no OCR process has been 
successfully run.  

To perform an OCR search in an advanced search, use the following syntax: 
{LF:OCR=Pages} 

where Pages is All, Some or None. 

Searches Using the Within Operator 

The Within operator can be used to create searches that will find all instances 
of two words or phrases within a certain number of words of each other.  This 
can help you find the specific document you are looking for, particularly if 
one of the search terms is very common and may match too many documents 
that are not the ones you are looking for. 

 There are two ways to perform a Within search.  You can do a Basic Text 
Search and select the Within option.  This will open a second set of options; 
here, you can input a second phrase, and determine the number of characters, 
sentences or paragraphs by which the two search terms can be separated.  
(Sentences, in this context, consist of 10 words; paragraphs consist of 50 
words.) 
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The Within search can also be done by typing into the box in the Advanced 
Text Search tab.  The syntax for a Within search is ^N, where N is the 
maximum distance in number of words by which the two search terms can be 
separated.  An advanced Within search can be combined with other advanced 
searches to refine search results further. 

 If you performed the search Apple ^3 Orange, the search would return all 
documents that contained the words Apple and Orange separated by zero, 
one, two or three words.  A document containing the phrase "Apple, Orange" 
would be returned, as would one containing "Apples and oranges," but a 
document containing the phrase "Apple, banana, cherry, pineapple, 
grapefruit, orange" would not be returned, as the terms apple and orange are 
separated by more than three words. 

 This can be useful in distinguishing documents that contain a certain set of 
words, but that do not necessarily have those words together in a set phrase. 

Search For Documents with a Blank Template Field 

You can use the Advanced Text Search option in Laserfiche to search for 
documents where a specified template field has been left blank. This can be 
useful for checking documents to ensure that important information is being 
set. 

For instance, an admissions office might want to ensure that a decision is 
made on all applications by a certain time. If Decision Status was set as a field 
on the Application template, they could use the Advanced Search syntax to 
locate all documents that did not have a value set on that field. 

{[Application]:[Decision Status]=""} 
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